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Introduction 1
NEC’s K0S Low-Cost Emulator (LCE-K0S) is an economical and comprehensive emulation 
system for developing embedded systems based on NEC’s K0S microcontrollers.  The LCE-
K0S supports most conventional in-circuit emulation functions and is also a flash programmer 
for K0S microcontrollers with flash memory (Figu re1-1).

The LCE-K0S consists of a motherboard (LCE-78K0S) that provides base functions for 
emulation and a daughterboard (LCE-789xxx-EM) that provides family-specific emulation 
functions.  The LCE-K0S uses a Microsoft® Windows®-based integrated debugger and 
interfaces to a personal computer via a printer or parallel port. 

Figure 1-1. LCE-K0S
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Shipping Contents ! Motherboard Package

• Motherboard
• 110V AC power adapter
• Getting Started Manual (document no. 50889)

• DB25 straight-through cable
• ID78K0S-LCE User’s Manual (document no. 50888-1)

! Daughterboard Package

• Daughterboard
• One or two ribbon cables

• CD-ROM containing software and documentation
• Daughterboard user’s manual

! Optional Accessories

• Emulation probe
• Flash adapter

Motherboard The main platform board, the motherboard, provides functions common to all K0S 
microcontrollers, as well as flash programming circuitry and tracing capability ( Figure1-2).  A 
clear plastic cover on top of the system protects it from fluid spills.

Figure 1-2. Motherboard
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The motherboard is designed with the components described in Ta ble1-1.  Each component is 
numbered to correspond with its location in Figure 1-3.

Figure 1-3.  Top View of the Motherboard (Component Side)

Table 1-1. Motherboard Components

Location Item Description

1 Power jack Connects the power adapter

2 Power switch Turns on/off power to the LCE

3 25-pin connector Connects a straight-through cable from the LCE to host PC

4 Reset button Hardware resets the LCE

5 Green power LED Indicates that power is being supplied to the LCE

6 Yellow LED Indicates the presence of the VPP signal during flash 
programming

7 3-pin male header, JP1 Sets the operating voltage for the LCE

8 2-pin male header, JP2 Enables or disables power (VPP) for flash programming

9 DB9 connecto Connects a flash adapter (sold separately) or a cable to 
perform on-board flash programming (cable included with 
flash adapter)

10 U35 footprint Reserved for user-installed crystal oscillator

11 40 MHz clock oscillato Main system clock

(5) Power-
On LED

(4) Reset
Button

(1) Power
Jack

(3) PC Host
Interface

(9) Flash
Programmer

Interface
(6) Flash Programming
LED

(7) Operating Voltag
Jumper

(8) Flash Programmer
Power Supply

(11) Main System
Clock Oscillator

(10) Footprint
for

User Clock

(2) Power
Switch
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Power Adapter

The main power supply for the LCE-K0S is a 110V AC power adapter that generates +5 volts 
(Figure 1-4).  It does not provide power to the user target.

Figure 1-4. Power Adapter

Parallel Cable

The parallel cable is  a 25-pin straight-through cable that connects the LCE-K0S to the host 
computer via a parallel port (Figure 1-5).

Figure 1-5. Parallel Cable
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Daughterboard The daughterboard connects to the bottom of the motherboard and provides peripheral 
functionality for a specific subseries of K0S microcontrollers (Figure 1-6).

Figure 1-6. Daughterboard

Ribbon Cable

The ribbon cable is a 50-pin female-to-female cable that connects the LCE-K0S to the user 
target (Figur e 1-7).  The emulation probe can be used alternat ively.

Figure 1-7. Ribbon Cable

���������������������������������������������
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Optional Accessories Emulation Probe

The emulation probe, sold separately, is an alternative way to connect the daughterboard to a 
user target (Figure 1-8).  One end of the probe connects to the 120-pin KEL connector on the 
daughterboard; the other end connects to a special socket on the user target.

Figure 1-8. Emulation Probe

Flash Adapter

A flash adapter is used to program a flash microcontroller (F igure1-9).  The adapter, a printed 
circuit board with a clam-shell socket and DB9 connector, must be wired so that the 
programming signals are transmitted to the connector.  The DB9 connector may be used to 
connect the flash adapter to the LCE-K0S directly or through the flash programming cable 
included with the flash adapter.

Figure 1-9. Flash Adapter
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Hardware Assembly 2
This section explains how to change the jumper settings, assemble the hardware components 
of the LCE-K0S, and establish connection to the host PC.

Changing the 
Jumper Settings

1. Unscrew the four plastic spacers underneath the motherboard (Figure 2-1).  Take special 
care when handling the small washers.

Figure 2-1.  Motherboard Cover and Screws

2. Remove the plastic cover on top of the motherboard.

Default Settings 3. Figure 2-2 shows the default jumper settings.

Figure 2-2.  Default Jumper Settings

Other Settings 4. To change the setting for JP1, refer to Figure 2-3.

Figure 2-3.  JP1 Setting for VDD = 3.3 V

 VDD =  5 .0  V

Vpp signal for flash programming is supplied by the KOS-LCE 

1 2 3

JP1

JP2

1 2 3

JP1
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5. To change the setting for JP2, refer to Figure 2-4.

Figure 2-4.  JP2 Setting for VPP Supplied by User Target

6. Replace the plastic cover on top of the motherboard.

7. Replace the washers and screws.

Connecting the 
Boards

1. Make sure power is off.

2. Remove the two front screws at the bottom of the standoffs of the motherboard 
(Figure 2-5)

Figure 2-5.  Motherboard Screws

3. Connect the ribbon cables (Figure 2-6) or the probe (Figure 2-7) to the respective 
connectors on the daughterboard. Note that some daughterboards may come with 
only one ribbon cable.

Figure 2-6.  Ribbon Cables

JP2

����������
�����

������
���

Ribbon Cables
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Figure 2-7.  Emulation Probe (Optional)

4. With the daugherboard on a stable surface, connect the motherboard to the top of 
the daughterboard by gently applying pressure on the mating connectors.  Avoid 
applying too much pressure directly onto the plastic cover (Figure 2-8).

Figure 2-8.  Motherboard/Daughterboard Connections

5. Replace  the screws on the bottom of the daughterboard to secure the 
connections with the motherboard (Figure 2-9).

Figure 2-9.  Securing the Connections

6. Connect the loose end of the ribbon cable or the probe to the user target.  Refer to 
the daughterboard manual for pin assignments.

7. Use the 25-pin, male-to-male, straight-through cable included with the mother-
board to connect to the printer or parallel port of the host (Figure 2-10).

Emulation Probe (sold separately)

����������
�����
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Figure 2-10.  Host PC Connections

Establishing 
Communication

With the LCE-K0S power adapter connected, turn the switch to the ON position.  The green 
LED on the motherboard will light when power is supplied to the system.  The LCE-K0S is now 
ready to communicate with the software debugger.

For proper communication, the parallel port of the PC must be configured as a BIDIRECTIONAL 
port.  In most cases, the port will be configured correctly.  If not, enter into the BIOS of the PC 
and make the modifications.  Refer to the user’s manual for your PC for details.

����������������������������
����������������������������
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Rear Side of  the Mother Board
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Software Installation 3
Obtaining a Password Before installing the software, obtain a password from NEC Electronics Inc.

1. Call 1-800-366-9782.  Press 1 for Literature and then press 1 again to speak to a 
representative who will assist you with LCE registration.

2. Provide your company information and the exact serial number printed on the motherboard.

Installing the Software The following procedure explains how to install the software for the LCE-K0S.  At any time 
during the procedure, click Back to return to the previous screen or Cancel to cancel the 
installation.

1. Load the CD-ROM into the drive.  If the autorun feature is enabled in your CD-ROM drive, 
the License Agreement dialog box appears automatically after a few seconds 
(Figure 3-1).  Alternatively, you may run the executable from the Star  menu.  Click Run ➙ 
Browse and select the CD-ROM drive letter to view the contents of the CD-ROM.  Select 
NEC.EXE and then click Open ➙ OK.

Figure 3-1.   License Agreement
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2. Click Yes to accept the agreement and proceed to the Software Development 
Tools menu (Figur e 3-2) or click No to exit the program.

Figure 3-2.   Software Development Tools Menu

3. From the Software Development Tools menu, click Install Software to display 
the Install Software menu (Figu re 3-3).

Figure 3-3.   Install Software Menu
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4. From the Install Software menu, click Integrated Debugger to learn how to 
register the ID78K0S-LCE and obtain a password from NEC Electronics Inc. 
(Figure 3-4). Once you obtain a password, click Continue... to install the software.

Figure 3-4.   Password Information

5. The first screen in the ID78K0S-CCE install program is the Registration dialog 
box.  Here enter the motherboard serial number and password assigned by NEC 
Electronics Inc. and then click Next to continue (Figure 3-5).

Figure 3-5.   Registration Dialog Box
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6. Read the Welcome dialog box and click Next to continue (Figure 3-6).

Figure 3-6.   Welcome Dialog Box

7. In the Select Components dialog box, review the list of components (Figure 3-7).  
Clear those you do not wish to install and click Next to continue.  To change the 
destination folder for installation, click Browse.

Figure 3-7.   Select Components Dialog Bo
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8. In the Select Program Folder dialog box, click Next to accept the default program 
folder (Figure 3-8).  Otherwise, select another folder name and click Next to con-
tinue.

Figure 3-8.   Select Program Folder Dialog Box

9. In the Start Copying Files dialog box, review your settings.  If correct, click Next 
to install the program files (Figure 3-9).   To change your settings, click Back to 
return to previous screens and repeat any steps necessary.

Figure 3-9.   Start Copying Files Dialog Box
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10. Wait for the installation to complete or click Cancel to cancel it (Figure 3-10).

Figure 3-10.   Copying Files Message

11. Once the files are transferred to the host PC, you may choose to install the device 
files by checking the box in the Setup Complete dialog box.  Click Finish to exit 
the program (Figure 3-11).

Figure 3-11.   Setup Complete Dialog Box
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Removing Software 1. To remove the software, open the Star  menu from your desktop.  Click Settings ➙  
Control Panel ➙  Add/Remove Programs (Figure 3-12).

Figure 3-12.   Control Panel Window

2. In the Add/Remove Programs Properties dialog box, select NEC ID78K0S-LC
and then click Add/Remove.  Click OK to exit the dialog box (Figure 3-13).

Figure 3-13.   Add/Remove Programs Properties
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Operation 4
With power applied to the LCE-K0S, follow this procedure to launch the ID78K0S-LCE 
integrated debugger.

1. From the Star  menu, click Programs ➙  NEC Tools ➙  ID78K0S-LCE to open the 
Configuration dialog box (Figure 4-1).

Figure 4-1. Configuration Menu
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2. In the Configuration dialog box, select the device to emulate and then click OK to open the 
Main window (Figure 4-2).  The selected device must be supported by the daughterboard.  
Refer to the daughterboard user’s manual for a list of devices supported.

Figure 4-2. Main Window

Downloading a Load 
Module File

1. To download a load module file (the filecontaining source debugging information that is 
generated by the linker after it has compiled and assembled the source code) or a hex file 
to the emulator, click File to open the File menu (Figure 4-3).  Example code is included 
during installation for demonstration.

Figure 4-3. File Menu
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2. Click Download . . . to open the Download dialog box (Figure 4-4).

Figure 4-4. Download Dialog Box

3. Select a load module or hex file and click Open to load the file into the Source window 
(Figure 4-5). 

Figure 4-5. Source Window
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Setting a Breakpoint 1. From the Source window, you can set a breakpoint by moving your cursor to a line in the 
source and then clicking the asterisk to the far left (Figure 4-6).  This step causes a red B to 
appear at the breakpoint location; the source line is also highlighted in red.  To delete the 
breakpoint, click the red B.  The asterisk indicates a valid location for a breakpoint.

Figure 4-6. Breakpoint Selection

2. To execute the code at full speed in real time, select the Run menu and then click Go 
(Figure 4-7).  When the program counter (PC) reaches the breakpoint, program execution 
terminates and the Source window shows the current PC value, shown as  “>” in the 
second column.  The source line is also highlighted in yellow.

Figure 4-7. Run Menu
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3. To view other debugging  windows, open the Browse menu and click your selection 
(Figure 4-8).

Figure 4-8. Browse Menu

Viewing the Trace 
Window

To view tracing information in the Trace window, select Browse and then click Trace
(Figure 4-9).

Figure 4-9. Trace Window
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Saving a Project 1. To save the debugging windows and breakpoints in a project file, click File ➙  Project ➙  
Save As... (Figure 4-10).

Figure 4-10. Project Submenu

2. Select a directory, enter a project file name, and then click Save to save the file 
(Figure 4-11).

Figure 4-11. Save As Dialog Box
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Opening  a Project 1. To open a previously saved project file, click Star  ➙  Programs ➙  NEC Tools ➙  ID78K0S-
LCE.  From the Configuration dialog box, click Project... (Figure 4-12).

Figure 4-12. Configuration Dialog Box

2. From the Open dialog box, select the project file name and click Open (Figure 4-13).

Figure 4-13. Open Dialog Box
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3. The debugger loads the project and sets up all the windows and breakpoints exactly as 
they were last saved (Figure 4-14).

Figure 4-14. .PRJ File Displayed in Source Window
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Flash Programming 5
The LCE-K0S is equipped with a flash programmer for K0S microcontrollers with flash memory. 
The LCE-K0S supports only 3-wire serial I/O for flash programming. Table 5-1shows the pin 
configuration of the LCE-K0S DB9 connector.

1. With power off to the LCE-K0S, connect a flash programming adapter with a flash device to 
the DB9 connector of the LCE-K0S (Figure 5-1).

Figure 5-1. Clamshell Socket and DB9 Connector

2. Turn on power to the LCE-K0S.

3. Click Start ➙  Programs ➙  NEC Tools ➙  ID78K0S-LCE.

4. From the Configuration dialog box, select the proper device and click OK.

5. From the Main window, open the File menu and click Flash Program... (Figure 5-2).

Table 5-1. Pin Configuration of the LCE-K0S DB9 Connector

Pin Signal Name Specification

1 GND Ground

2 SI Serial data input

3 SO Serial data output

4 SCK Serial clock output

5 CLK Clock output to target

6 RESET RESET signal output to target (active low)

7 VDD VDD input/output to target

8 VPP VPP output to target

9 −
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Figure 5-2. Flash Program... Command

6. From the Flash Programming dialog box, click SSig Chk to check the silicon signature of 
the device (Figure 5-3).

Figure 5-3. Flash Programming Dialog Box

7. The flash programmer checks for the device and displays the part number in the Device: 
box (Figure 5-4).
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Figure 5-4. Successful Silicon Signature Check

8. To perform a blank check on the device, click the Blank Chk button.  To completely erase 
the entire device, click Erase.

9. To program the device, click Browse..., select a .HEX file and then click Open to download 
the file (Figure 5-5).

Figure 5-5. Open Dialog Bo

10. Click Write to program the device.  Keep in mind that programming time will vary depending 
on the size of the file.  Verify compares the contents of the flash device with the file.  Note 
that this function may take a few minutes because it verifies the contents of the entire 
device.
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11. To automate the programming sequence described above, click Program Sequence to 
execute the silicon signature check, blank check, erase (if necessary), and write 
operations in sequential order.

12. To exit the programmer, click OK.
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Troubleshooting 6
This section provides some helpful information for troubleshooting error messages from the 
LCE-K0S.  Table 6-1 explains how to correct the error message shown in Figure 6-1.

Communication 
Error

Figure 6-1. Communication Error

Error When Opening 
a Project

If you load a previously save project to the LCE-K0S and receive the error message shown in 
Figure 6-2,then the clock source saved in the project file does not match the clock source of the 
LCE-K0S

Figure 6-2. Failed Supervisor Command

Table 6-1. Troubleshooting a Communication Error

Possible Cause Solution

No power to the LCE Check that the LCE-K0S has power (green LED should be on).

Parallel cable not connected Connect a 25-pin straight-through cable.

Parallel port on the host PC not 
configured as bidirectional

Enter the host PC’s BIOS configuration and modify its parallel 
port as bidirectional.  Refer to the PC user’s manual for  
procedures about modifying the BIOS.

No daughterboard connected to the 
motherboard

Connect a daughterboard and select the appropriate device in 
the Configuration window.
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Open the .PRI file, an example of which is shown in Figure 6-3.  Change “Clock=User” to 
“Clock=5 MHz” and “SubClock=User” to “SubClock=32 kHz.”  Save the file and load it into the 
LCE-K0S.  To change the clock settings, open the Options menu and click Configuration....

Figure 6-3. Example .PRI FilFlash Programming Error

If you invoke the flash programming interface and receive the error message shown in Figure 
6-4, refer to Table 6-2 to detemine the possible cause of the problem.

Figure 6-4. Flash Programming Error

Write or Verify 
Errors

If you receive the message “Couldn’t allocate 312016898 bytes of memory for buffer,” when you 
perform a Write or Verify operation, perform a Silicon Signature check before performing the 
Write or Verify operation.

Table 6-2. Troubleshooting a Flash Programming Error

Possible Cause Solution

No flash device connections Connect a K0S flash micrcontroller.

Incorrect signal connections Make sure all LCE-K0S connector pins are connected to the 
proper pins of the flash micrcontroller.  On some devices, 
connect VSS0 with VSS1 and VDD0 with VDD1.

No VPP signal Connect the jumper on the JP2 header of the LCE-K0S.

Flash device not supporte Connect only a K0S flash device.

[Project.ID]
Ver=200
Target=IDK0S32L

[Configuration]
Chip=µPD78F9418
Internal Rom=32KB
Internal Ram=512B
Clock=User   <<<
SubClock=User   <<<
Voltage=Internal
.
.
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Functional Description 7
The LCE-K0S implements a motherboard/daughterboard design (Figure 7-1).  Because of the 
standard peripheral bus in the K0S microcontroller’s CPU, one motherboard is used for all LCE-
K0S systems. The motherboard contains the K0S CPU Evachip, the flash programmer, and the 
parallel interface to the PC. The daughterboard is unique for each K0S subseries and contains a 
K0S real-chip with all the peripherals found in the K0S device being emulated.  The 
motherboard and daughterboard interface using NEC’s real-chip peripheral bus.

Features ! Real-time in-circuit emulation

! Fully equipped flash programmer

! RAM-based control software for easy upgrade of control software versions

! 5- or 3-volt signal emulation

! Breakpoint settings

• Up to 16 program (ROM) fetch breakpoints

• Up to 2 data (RAM) breakpoints:  break on read, write, and read/write

! Trace capabilities

• 64 bits per frame by 64K frames

• Trace window that displays assembly code or mixed C and assembly code

• Three tracing modes
– Unconditional

– Qualified (if an event condition is satisfied)

– Sectional (starts and ends by event triggering)

! Window synchronizing: frames displayed in the Trace View window are highlighted in the 
Source Code window

! Time stamping
•  Max. time:   7.15 min.–14.32 min.  
•   Resolution:  100 ns or 200 ns  

! Parallel interface to PC via DB25 connector

! Windows-based integrated debugger

! Source-level debugging in C language or Assembly language

! Emulation memory

• Up to 48 KB internal ROM

• Up to 1 KB internal RAM
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The control software for the LCE-K0S is RAM-based to allow the controlling program to be 
down-line loaded each time the system is started.  This feature allows for easy upgrading of new 
control software versions.

Figure 7-1.    LCE-K0S Block Diagram

uPD78K0S
Realchip

(Periph. Evachip)

Daughter Board

Realchip Interface

System  Bus

Host-System Interface
(Bi-Dir. Parallel Port)

DB25
Connector

uPD789009
(K0S-Evachip)

Flash Programmer
Interface

DB9
Connector

Mother Board
C

on
ne

ct
or

 w
it

h
K

0S
-D

ev
ic

e 
Pi

n-
ou

ts

T
o 

U
se

rs
’

T
ar

ge
t 

Sy
st

em



LCE-K0S Getting Started Manual 7-3

Functional Description

Table 7-1.  Specifications

Parameter Specifications

System operating 
voltage 

Main power supply VCC = 5 V plus/minus 5%,  wall-mounted power supply

Real chip VDD = 3.3 V,  5% (LCE-K0S internally generated)

Flash program VPP = 10 V,   5% (LCE-K0S internally generated)

System operating 
frequencies

Main clock 10 MHz; system installed

Subclock 32.768 kHz; system Installed

CMOS logic needed to buffer the user-supplied clock from target

Footprint for user-installed crystal oscillator provided

Host interface Bidirectional parallel port

Connect LCE-K0S to host PC using 25-pin straight-through DB25 cable

Flash programming 
interface

Connect program adapter to DB-9 connector on the motherboard

Connect target system for on-board programming through DB-9 connector on the motherboard

Program memory  
and data memory

Program memory up to 48 KB; provided by K0S Evachip 

Data memory up to 1 KB; provided by K0S Evachip

Probe connection to 
user system

Cable probe Socket connector to socket connector; 6-inch cable

Special probe Socket connector to device socket (available as option) 

Break event detection Program execution status detection

Bus event detection 

Trace memory  64 bits per frame by 64K frames 

Trace address, data, and execution status

Time  stamp   for  measuring  execution   time:                                                                       7.15 min. @ 100 ns count rate or,

14.32 min. @ 200 ns count rate

 Event integration Linking events

Platform board 
dimensions

Motherboard Approximately 6.5” x 4.5” (16.5 cm x 11.5 cm)

Daughterboard Approximately 4.0” x 4.5” (10.4 cm x 11.5 cm)

Combined 8.5” (L) x 4.5” (W) x 2.0” (H) (21.6 cm x 11.5 cm x 5.1 cm)
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